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1 Introduction

eric 4.1 introduced a plug-in system, which allows easy extension of the IDE. Every user
can customize the application by installing plug-ins available via the Internet. This
document describes this plug-in system from a user perspective and from a plug-in
developers perspective as well.

2 Description of the plug-in system

The eric6 plug-in system is the extensible part of the eric6 IDE. There are two kinds of
plug-ins. The first kind of plug-ins are automatically activated at startup, the other kind are
activated on demand. The activation of the on-demand plug-ins is controlled by
configuration options. Internally, all plug-ins are managed by the PluginManager object.
Deactivated autoactivate plug-ins are remembered and will not be activated automatically
on the next start of eric6.

Ericé comes with quite a number of core plug-ins. These are part of the eric6 installation.
In addition to this, there are additional plug-ins available via the internet. Those plug-ins
may be installed and uninstalled using the provided menu or toolbar entries. Installable
plug-ins live in one of two areas. One is the global plug-in area, the other is the user plug-
in area. The later one overrides the global area.

3 The plug-in system from a user perspective

The eric6 plug-in system provides the user with a Plug-ins menu in the main menu bar and
a corresponding toolbar. Through both of them the user is presented with actions to show
information about loaded plug-ins and to install or uninstall plug-ins.

3.1 The Plug-ins menu and toolbar

The plug-ins menu is located under the “Plugins” label in the main menu bar of the eric6
main window. It contains all available user actions and is accompanied by a toolbar
containing the same actions. They are shown in the following figures.

File Edit “iew Start Debug Unittest Project Extras Settings Window Eookmarksﬂelp

Figure 1: eric6 main menu

.. PluginInfos. ..
. Install Plugins. ..

& Uninstall Plugin...
al Plugin Repository..
Configure...

Figure 2: The Plug-ins menu
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- H - Ak
Figure 3: The Plug-ins toolbar

The “Plugin Infos...” action is used to show a dialog, that lists all the loaded plug-ins and
there status. The entry labeled “Install Plugins...” opens a wizard like dialog to install new
plug-ins from plug-in archives. The entry, “Uninstall Plugin...”, presents a dialog to uninstall
a plug-in. If a plug-in to be uninstalled is loaded, it is unloaded first. The entry called
“Plugin Repository...” shows a dialog, that displays the official plug-ins available in the
eric6 plug-in repository. The “Configure...” entry opens the eric6 configuration dialog
displaying the Plugin Manager configuration page.

3.2 The Plug-in Infos dialog

The “Plugin Infos” dialog shows information about all loaded plug-ins. Plug-ins, which had
a problem when loaded or activated are highlighted. More details are presented, by double
clicking an entry or selecting the “Show details” context menu entry. An example of the
dialog is show in the following figure.

21 | Loaded Plugins

Doukle-Click an entry to show detailed info. Plugins with an error are shown in red.

|I'u'|odu|e |Name |\f‘ersion Autoactivate |ﬁctive |Description

PluginAbout About Plugin 420 Yes Yes ShowtheAhout dialogs.
FluginAssistantEric Assistant Eric Flugin 1.0.0-snapshot-20080716 fes Yes  Alternative autocompletion and cal
FluginCharTakles CharTahles Plugin 413 fes Yes Dialog showing various characterd
FluginCxFreeze CxFreeze Plugin 413 fes Yes Showthe CxFreeze dialogs.
FluginEricapi Ericapi Flugin 4.20 fes Yes Showthe Ericapi dialogs.
FluginEricdoc Ericdoc Plugin 4.20 fes Yes Showthe Ericdoc dialogs.
PluginProjectDjango Django Project Plugin 1.01 Yes Yes Project supportfor Django projects
PluginProjectTurboGears  TurhoGears Project Plugin - 1.0.1 Yes Yes Project supportfor TurboGears pro
PluginProjectxPython wixPython Project Plugin 1.01 Yes Yes Project support for wxPython projec
PluginPyLint PyLint Plugin 412 Yes Yes Showthe PyLint dialogs.
PluginRefactoringBRM Refactoring BRM Plugin 412 Yes Mo Refactoring with Bicycle Repair Ma
PluginRefactoringRope Refactoring Rope Plugin 1.1.0-snapshot-20080712 Yes Yes Refactoring using the Rope library.
PluginSyntaxChecker Syntax Checker Plugin 420 Yes Yes Showthe Syntax Checker dialog.
PluginTabnanny Tabnanny Plugin 420 Yes Yes Showthe Tabnanny dialog.
PluginvcsCWs CWS Plugin 4148 Mo Mo Implements the CVS version contn
PluginVcsPySwvn PySvn Plugin 420 Mo Yes Implements the PySvn version con
FluginvcsSubversion Subversion Plugin 4.20 Mo Mo Implements the Subversion versio
FluginvmListspace Listspace Flugin 4.20 Mo Mo Implements the Listspace view mz
FluginVmMdifrea Workspace Plugin 1.0.0 Mo Mo Implements the MDlArea view mar
FluginvmTabview Tabview Plugin 4.20 Mo Implements the Tabview view man
FluginvmWaorkspace Workspace Plugin 4.20 Mo Mo Implements the Workspace view n
FluginWizardPyRegExp Python re Wizard Plugin 4.20 Show the Python re wizard.
FluginWizardQColorDialog @ColorDialog Wizard Plugin 4.2.0 Show the QColorDialog wizard.
FluginWizardQFileDialog  QFileDialog Wizard Plugin 4.20 Show the QFileDialog wizard.
FluginWizard@FontDialog  QFontDialog Wizard Plugin 4.2.0 Show the QFontDialog wizard.
PluginWizardQInputDialog  QInputDialog Wizard Flugin - 4.2.0 Show the QlnputDialog wizard.
PluginWizardGMessageBox QGMessageBox Wizard Plugin 4.2.0 Show the OMessageBox wizard.
PluginWizardQRegExp QRegExp Wizard Plugin 420 Show the QRegExp wizard.

£l

oo

Figure 4: Plug-ins Info dialog
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The columns show information as follows.

e Module
This shows the Python module name of the plug-in. It is usually the name of the
plug-in file without the file extension. The module name must be unique.

e Name
This is the name of the plug-in as given by the plug-in author.

e \Version
This shows the version of the plug-in.

e Autoactivate
This indicates, if the plug-in should be activated at startup of the eric6 IDE. The
actual activation of a plug-in is controlled by the state it had at the last shutdown of
eric6.

e Active
This gives an indication, if the plug-in is active.

e Description
This column show a descriptive text as given by the plug-in author.

This dialog has a context menu, which has entries to show more details about a selected
plug-in and to activate or deactivate an autoactivate plug-in. It is shown below.

Show details Show details
Activate
Deactivate

Figure 5: Plug-ins Info dialog context menu

Deactivated plug-ins are remembered and will not be activated automatically at the next
startup of eric6. In order to reactivate them, the “Activate” entry of the context menu must
be selected.

Selecting the “Show details” entry opens another dialog with more information about the
selected plug-in. An example is shown in the following figure.
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Description: This plugin implements refactoring functionality using the Bicycle

] Plugin Details
Module name: PluginRefactoringBRM

Module filename: [fhamefdetlew’.eric4feric4p|uginsfF’IuginﬁefactDringBRM.pj,r

[®| Autoactivate [ | Active

Plugin name: [Refactnring BRM Plugin

\ersion: [4.1.D

Authar: [Detlev Offenbach =detlev@die-offenbachs. de=

Repair Man package.

Figure 6: Plug-in Details dialog

The entries of the dialog are as follows.

Module name:
This shows the Python module name of the plug-in. It is usually the name of the
plug-in file without the file extension. The module name must be unique.

Module filename:
This shows the complete path to the installed plug-in Python file.

Autoactivate

This indicates, if the plug-in should be activated at startup of the ericé IDE. The
actual activation of a plug-in is controlled by the state it had at the last shutdown of
eric6.

Active
This gives an indication, if the plug-in is active.

Plugin name:
This is the name of the plug-in as given by the plug-in author.

Version:
This shows the version number of the installed plug-in. This number should be
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passed to the plug-in author when reporting a problem.

e Author:
This field gives the author information as provided by the plug-in author. It should
contain the authors name and email.

e Description:
This shows some explanatory text as provided by the plug-in author. Usually this is
more detailed than the short description displayed in the plug-in infos dialog.

e Error:
In case a plug-in hit an error condition upon loading or activation, an error text is
stored by the plug-in and show in this field. It should give a clear indication about
the problem.

3.3 Installing Plug-ins

New plug-ins are installed from within eric6 using the Plug-in Installation dialog. It is show,
when the “Install Plugin...” menu entry is selected. Please note, that this is also available
as a standalone tool using the eric6_plugininstall. py script or via the eric6 tray
menu. The user is guided through the installation process by a wizard like dialog. On the
first page, the plug-in archives are selected. eric6 plug-ins are distributed as ZIP-archives,
which contain all installable files. The “Add ...”-button opens a standard file selection
dialog. Selected archives may be removed from the list with the “Remove”-Button.
Pressing the “Next >” button continues to the second screen.

[] Plugin Installation

Enter the plugin archives to install

fhome/detlev/.ericd/Downloads/PluginCharTables.zip
fhome/detlev/.ericd/Downloads/PluginCxFreeze.zip

fhomefdetlevf.ericd/Downloads/PluginPyLint.zip
fhome/detlev/. eric4/Downloads/PluginRefactoringBRM.zip

fhome/detlev/.eric4/Downloads/PluginvcsCVs.zip

[ - Back H Next > H Finish H Cancel ]

Figure 7: Plug-ins Installation dialog, step 1

The second display of the dialog is used to select the directory, the plug-in should be
installed into. If the user has write access to the global ericé plug-ins directory, both the
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global and the user plug-ins directory are presented. Otherwise just the user plug-ins
directory is given as a choice. With the “< Back” button, the user may go back one screen.
Pressing “Next >” moves to the final display.

B Plugin Installation

Select the destination plugin directory

[User plugins directory

[ < Back H Next > H Finish H Cancel ]

Figure 8: Plug-ins Installation dialog, step 2

The final display of the plug-in installation dialog shows a summary of the installation data
entered previously. Again, the “< Back” button lets the user go back one screen. The
“Finish” button is used to acknowledge the data and starts the installation process.
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B Plugin Installation

Installation Summary

Plugin ZIP-Archives:
fhome/detlev/.ericd/Downloads/PluginCharTables.zip
fhome/detlev/.ericd/Downloads/PluginCxFreeze.zip
fhome/detlev/.ericd/Downloads/PluginPyLint.zip
fhome/detlev/. ericd/Downloads/PluginRefactoringBRM.zip
fhome/detlev/.eric4/Downloads/FluginvcsCVs.zip

Destination:
User plugins directory (fhome/detlev/.ericd/ericdplugins)

0%

l = Back H Mext =

Figure 9: Plug-ins Installation dialog, step 3

The installation progress is show on the very same page. During installation the plug-in
archives is checked for various conditions. If the installer recognizes a problem, a
message is shown and the installation for this plug-in archive is aborted. If there is a
problem in the last step, which is the extraction of the archive, the installation process is
rolled back. The installation progress of each plug-in archive is shown by the progress bar.
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H] Plugin Installation

Installation Summary

Installing /home/detlev/.ericd/Downloads/PluginCharTables.zip ...
Inﬂsfalling fhome/detlevl. ericd/Downloads/PluginCxFreeze.zip ...
Inﬂs}:alling fhome/fdetlev/.ericd/Downloads/PluginPyLint.zip ...
InﬂsL’:aIIing fhome/detlev/.ericd/Downloads/PluginRefactoringBRM.zip ...
Inﬂs}:alling fhome/detlev/.ericd/Downloads/PluginvcsCWVs.zip ...

ok

IRRRERERRRRERRTCRRRRRERERENEE]

[ < Back H Next = H Finish H Cancel ]

Figure 10: Plug-ins Installation dialog, step 4

Once the installation succeeds, a success message is shown.

H Plugins Installation

@ The plugins were installed successfully

Figure 11: Plug-ins Installation dialog, step 5

If plug-ins are installed from within eric6é and are of type “autoactivate”, they are loaded
and activated immediately. Otherwise they are loaded in order to add new on-demand
functionality.

3.4 Uninstalling Plug-ins

Plug-ins may be uninstalled from within eric6 using the “Uninstall Plugin...” menu, via the
eric6_pluginuninstall. py script or via the eric6 tray menu. This displays the “Plugin
Uninstallation” dialog, which contains two selection list. The top list is used to select the
plug-in directory. If the user has write access in the global plug-ins directory, the global and
user plug-ins directory are presented. If not, only the user plug-ins directory may be
selected. The second list shows the plug-ins installed in the selected plug-ins directory.
Pressing the “OK” button starts the uninstallation process.
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B Plugin Uninstallation
Plugin directory

[User plugins directory

Plugin:

[F’IuginRefactc:ringBRM

(0]4 H Cancel l

Figure 12: Plug-in Uninstallation dialog, step 1

H1Plugin Uninstallation <2>

@ The plugin PluginRefactoringBRM was uninstalled successfully
from /fhome/detlev/. ericd/eric4plugins.

Figure 13: Plug-in Uninstallation dialog, step 2
The uninstallation process deactivates and unloads the plug-in and finally removes all files
belonging to the selected plug-in from disk. This process ends with a message confirming
successful uninstallation of the plug-in.

3.5 The Plug-ins repository

ericé has a repository, that contains all official plug-ins. The plug-in repository dialog may
be used to show this list and download selected plug-ins.
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t o erics py DR CTRONES
Name Version Short Description |
Stable
API Files 111 API files for Auto-Completion and Calltips.
Assistant, Erich 26.2 Alternative autocompletion provider.
Checkers, PyLint 531 Interface to the pylint checker program.
Issue Tracker 141 Simple issue tracker.
Packagers, CxFreeze 521 Interface to the cxfreeze packaging program.
Project, Django 3.21 Basic support for Django projects.
Project, Kivy 111 Basic support for Kivy projects.
Project, Pyramid 131 Basic support for Pylons projects.
Refactoring, Rope 232 Refactoring using the Rope refactoring library.
Time Tracker 121 Time Tracker to keep track of the project time.
Unstable
Camel Case Handling Tool 0.2.0 Tool to split, merge or convert camel case text.
Invert Hex Color Tool 0.1.0 Tool to invert the selected hex color string.
Print Remover Tool 0.2.0 Tool to remove print() like debug statements.
PySide to PyQt4 Converter Tool 0.2.0 Tool to convert PySide files to PyQtd and vice versa.
setup.py Wizard 0.4.0 Wizard for the creation of a setup.py file.
Description:
Author: [ ]
URL: [ ]
[ 0% )
Repository URL: [http:ﬂeric-ide_py‘thon-projects_orgfpIuginsSJ’repository_xml ] Edit URL
[ Update ] [ Download l [ Download & Install ] [ Cancel ] [ Close & Install ] [ € Close ]

Figure 14: Plug-in Repository dialog

The upper part of the dialog shows a list of available plug-ins. This info is read from a file
stored in the eric6 user space. Using the Update button, this file can be updated via the
Internet. The plug-ins are grouped by their development status. An icon next to the version
entry indicates, whether this plug-in needs an update. More detailed data is shown in the
bottom part, when an entry is selected. The data shown is the URL of the plug-in, some
detailed description and the author of the plug-in. Pressing the Download button gets the
selected plug-ins from the presented URL and stores them in the user's plug-in download
area, which may be configured on the Plug-ins configuration page of the configuration
dialog. The Cancel button will interrupt the current download. The download progress is
shown by the progress bar. Pressing the Close & Install button will close this dialog
and open the plug-in installation dialog (s. chapter 3.3) The Download & Install
button download the selected plug-ins, closes the dialog and opens the plug-in installation
dialog. The Repository URL entry shows the location the repository data is downloaded
from. By pressing the Edit URL button, this location might be changed by the user in
case the location changes and the changed location could not be updated remotely.
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4 Eric6 for plug-in developers

This chapter contains a description of functions, that support plug-in development with

eric6. Eric6 plug-in projects must have the project type “Eric6 Plugin”. The project's main
script must be the plug-in main module. These project entries activate the built-in plug-in
development support. These are functions for the creation of plug-in archives and special
debugging support. An example of the project properties is shown in the following figure.

& Froject Properties & g &
Project Mame: PluginEricAssistant]
Spell Checking Properties...

Progr. Language: Python3 -

Mixed programming languages
Project Type: -
Project Directony: ‘detlew/Development/Python/EricS/ericé_plugins/Flugin_Assistant_Eric| &=
Version Mo.:

3x
ain Script: PluginAssistantEric.py —

Translations Properties. ..

End of Line Character: | Unix -
Authar: Detlev Offenbach
Emalil: detlev@die-ofenbachs de
Description: Plugin implementing an alternative autocompletion and calltips
provider.
The project is version controlled by Mercurial. Show Repositary Info

QK Cancel

Figure 15: Plug-in specific project properties

To support the creation of plug-in package archives, the Packagers submenu of the Project
menu contains entries to ease the creation of a package list and to create the plug-in
archive.
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4§ Create Package List
«p Create PluginArchive

- Create Plugin Archive (Snapshot)

Figure 16: Packagers submenu

The “Create package list” entry creates a file called PKGLIST, which is used by the archive
creator to get the list of files to be included in the plug-in archive. After the PKGLIST file
has been created, it is automatically loaded into a new editor. The plug-in author should
modify this list and shorten it to just include the files required by the plug-in at runtime. The
following listing gives an example.

AssistantEric/APIsManager.py

AssistantEric/Assistant.py
AssistantEric/ConfigurationPages/AutoCompletionEricPage.py
AssistantEric/ConfigurationPages/AutoCompletionEricPage.ui
AssistantEric/ConfigurationPages/CallTipsEricPage.py
AssistantEric/ConfigurationPages/CallTipsEricPage.ui
AssistantEric/ConfigurationPages/ init .py
AssistantEric/ConfigurationPages/eric.png
AssistantEric/Documentation/LICENSE.GPL3
AssistantEric/ init .py
AssistantEric/il8n/assistant cs.qgm
AssistantEric/il8n/assistant _de.qgm
AssistantEric/il8n/assistant _en.qgm
AssistantEric/il8n/assistant es.qgm
AssistantEric/il8n/assistant fr.qgm
AssistantEric/il8n/assistant _it.qgm
AssistantEric/il8n/assistant _ru.qgm
AssistantEric/il8n/assistant zh CN.GB2312.gm
PluginAssistantEric.py

Listing 1: Example of a PKGLIST file

The PKGLIST file must be stored in the top level directory of the project alongside the
project file.

The archive creator invoked via the “Create Plugin Archive” menu entry reads this
package list file and creates a plug-in archive. This archive has the same name as the
plug-in module and is stored at the same place. The menu entry “Create Plugin
Archive (Snapshot)”is used to create a snapshot release of the plug-in. This
command modifies the version entry of the plug-in module (see below) by appending a
snapshot indicator consisting of “-snapshot-" followed by the date like “20141224".

In order to debug a plug-in under development, ericé has the command line switch
“--plugin=<plugin module filename>". That switch is used internally, if the project
is of type “Eric6 Plugin”.

Page 17 of 55



The eric6 plug-in system

5 Anatomy of a plug-in

This chapter describes the anatomy of a plug-in in order to be compatible with eric6.

5.1 Plug-in structure

An eric6 plug-in consists of the plug-in module file and optionally of one plug-in package
directory. The plug-in module file must have a filename, that starts with Plugin and ends
with . py, e.g. PluginRefactoringBRM. py. The plug-in package directory may have an
arbitrary name, but must be unique upon installation. Therefore it is recommended to give
it the name of the module without the P1lugin prefix. This package directory name must
be assigned to the packageName module attribute (see the chapter describing the plug-in
module header).

5.2 Plug-in header

The plug-in module must contain a plug-in header, which defines various module
attributes. An example is given in the listing below.

# Start-0f-Header

name = "Assistant Eric Plugin"

author = "Detlev Offenbach <detlev@die-offenbachs.de>"
autoactivate = True

deactivateable = True

version = "1.2.3"

className = "AssistantEricPlugin"

packageName = "AssistantEric"

shortDescription = "Alternative autocompletion and calltips provider."
longDescription = """This plugin implements an alternative autocompletion"""

""" and calltips provider."""
needsRestart = True
pyqtApi = 2
python2Compatible = True
# End-0f-Header

error =

Listing 2: Plug-in header

The various attributes to be defined in the header are as follows.

e Nname
This attribute should contain a short descriptive name of the plug-in.
Type: string
e author
This attribute should be given the name and the email address of the plug-in author.
Type: string
e autoactivate
This attribute determines, whether the plug-in may be activated automatically upon

startup of eric6. If this attribute is False, the plug-in is activated depending on some
configuration settings.
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Type: bool

e deactivateable

This attribute determines, whether the plug-in may be deactivated by the user.
Type: bool

e version
This attribute should contain the version number.
Type: string

e className
This attribute must contain the name of the class implementing the plug-in. This
class must be contained in the plug-in module file.
Type: string

e packageName
This names the package directory, that contains the rest of the plug-in files. If the
plug-in is of the simple type (i.e. all logic is contained in the plug-in module), the
packageName attribute must be assigned the value “None” (the string None).
Type: string

e shortDescription
This attribute should contain a short description of the plug-in and is used in the
plug-in info dialog.
Type: string

e longDescription
This attribute should contain a more verbose description of the plug-in. It is shown
in the plug-in details dialog.
Type: string

e needsRestart
This attribute should make a statement, if ericé needs to be restarted after plug-in

installation or update.
Type: boolean

e pyqtApi
This attribute should indicate the PyQt QString and QVariant API version the plug-in
is coded for. Eric6 plug-ins must support at least version 2.
Type: integer

e python2Compatible
This attribute is introduced in eric 5.5. Each plug-in has to signalize if it supports the
execution when eric is started in a Python 2 interpreter.
Type: boolean

e error
This attribute should hold an error message, if there was a problem, or an empty
string, if everything works fine.
Type: string

e The'# Start-0Of-Header'and'# End-Of-Header' comments mark the start
and the end of the plug-in header.

If the autoactivate attribute is False, the header must contain two additional attributes.
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pluginType = "viewmanager"
pluginTypename = "tabview"

Listing 3: Additional header for on-demand plug-ins

e pluginType
This attribute must contain the plug-in type. Currently ericé recognizes the values
“viewmanager” and “version_control”.
Type: string
e pluginTypename
This attribute must containe the plug-in type name. This is used to differentiate the
plug-in within the group of plug-ins of the same plug-in type.
Type: string
Plug-in modules may define additional optional attributes. Optional attributes recognized
by eric6 are as follows.

e displayString
This attribute should contain the user visible string for this plug-in. It should be a
translated string, e.g. displayString = QApplication.translate('VcsCVSPlugin',
'CVS'). This attribute may only be defined for on-demand plug-ins.
Type: string

If either the version or the className attribute is missing, the plug-in will not be loaded. If
the autoactivate attribute is missing or this attribute is False and the pluginType or the
pluginTypename attributes are missing, the plug-in will be loaded but not activated. If the
packageName attribute is missing, the plug-in installation will be refused by eric6.

5.3 Plug-in module functions

Plug-in modules may define the following module level functions recognized by the eric6
plug-in manager.

e moduleSetup()
e prepareUninstall()
e getConfigData()
e previewPix()
e exeDisplayData() alternative exeDisplayDataList()
e apiFiles(language)
e clearPrivateData()
These functions are described in more detail in the next few chapters.

5.3.1 moduleSetup()

This function may be defined for on-demand plug-ins (i.e. those with autoactivate being
False). It may be used to perform some module level setup. E.g. the CVS plug-in uses this
function, to instantiate an administrative object to provide the login and logout menu
entries of the version control submenu.
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def moduleSetup():

Public function to do some module level setup.

global  cvsAdminObject
__cvsAdminObject = CVSAdminObject()

Listing 4: Example for the moduleSetup() function

5.3.2 prepareUninstall()

import Preferences

def prepareUninstall():

Module function to prepare for an uninstallation.

Preferences.Prefs.settings.remove("Refactoring")
Preferences.Prefs.settings.remove("RefactoringBRM")

Listing 5: Example for the prepareUninstall() function

This function is called by the plug-in uninstaller just prior to uninstallation of the plug-in.
That is the right place for cleanup code, which removes entries in the settings object or
removes plug-in specific configuration files.

5.3.3 getConfigData()

This function may be used to provide data needed by the configuration dialog to show an
entry in the list of configuration pages and the page itself. It is called for active autoactivate
plug-ins. It must return a dictionary with globally unique keys (e.g. created using the plug-
in name) and lists of five entries. These are as follows.

e display string
The string shown in the selection area of the configuration page. This should be a
localized string.
Type: Qstring
e pixmap name
The filename of the pixmap to be shown next to the display string.
Type: string

e page creation function
The plug-in module function to be called to create the configuration page. The page
must be subclasses from
Preferences.ConfigurationPages.ConfigurationPageBase and must
implement a method called 'save’ to save the settings. A parent entry will be created
in the selection list, if this value is None.
Type: function object or None

e parent key

The dictionary key of the parent entry or None, if this defines a toplevel entry.
Type: string or None
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e reference to configuration page
This will be used by the configuration dialog and must always be None.
Type: None

def getConfigData():

Module function returning data as required by the configuration dialog.

@return dictionary with key "refactoringBRMPage" containing the
relevant data
return {
"refactoringBRMPage" : \
[QApplication.translate("RefactoringBRMPlugin",
"Refactoring (BRM)"),
os.path.join("RefactoringBRM", "ConfigurationPage",
"preferences-refactoring.png"),

createConfigurationPage, None, None],

Listing 6: Example for the getConfigData() function

5.3.4 previewPix()

This function may be used to provide a preview pixmap of the plug-in. This is just called for
viewmanager plug-ins (i.e. pluginType == "viewmanager"). The returned object must be of
type QPixmap.

def previewPix():

Module function to return a preview pixmap.

@return preview pixmap (QPixmap)

fname = os.path.join(os.path.dirname( file ),
"ViewManagers", "Tabview", "preview.png")

return QPixmap(fname)

Listing 7: Example for the previewPix() function
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5.3.5 exeDisplayData()

This function may be defined by modules, that depend on some external tools. It is used
by the External Programs info dialog to get the data to be shown. This function must return
a dictionary that contains the data for the determination of the data to be shown or a
dictionary containing the data to be shown.

The required entries of the dictionary of type 1 are described below.

programgéntry
An indicator for this dictionary form. It must always be True.
Type: bool

header

The string to be diplayed as a header.

Type: Qstring

exe

The pathname of the executable.

Type: string

versionCommand

The version commandline parameter for the executable (e.g. - -version).
Type: string

versionStartsWith

The indicator for the output line containing the version information.

Type: string

versionPosition

The number of the element containing the version. Elements are separated by a
whitespace character.

Type: integer

version

The version string to be used as the default value.

Type: string

versionCleanup

A tuple of two integers giving string positions start and stop for the version string. It
is used to clean the version from unwanted characters. If no cleanup is required, it

must be None.
Type: tuple of two integers or None
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def exeDisplayData():

Public method to support the display of some executable info.

@return dictionary containing the data to query the presence of
the executable

exe = 'pylint'

if sys.platform == "win32":
exe = os.path.join(sys.exec prefix, "Scripts", exe + '.bat')

data = {
"programEntry" : True,
"header" : QApplication.translate("PyLintPlugin",

"Checkers - Pylint"),

"exe" : exe,
"versionCommand" : '--version',
"versionStartsWith" : 'pylint',
"versionPosition" -1,
"version" e
"versionCleanup" (0, -1),

}

return data

Listing 8: Example for the exeDisplayData() function returning a dictionary of type 1

The required entries of the dictionary of type 2 are described below.

e programgntry
An indicator for this dictionary form. It must always be False.
Type: bool

e header
The string to be diplayed as a header.
Type: string
e text
The entry text to be shown.
Type: string
e version

The version text to be shown.
Type: string
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def exeDisplayData():

Public method to support the display of some executable info.

@return dictionary containing the data to be shown
try:
import pysvn
try:
text = os.path.dirname(pysvn. file )
except AttributeError:
text = "PySvn"
version = ".".join([str(v) for v in pysvn.version])
except ImportError:
text = "PySvn"

version =
data = {
"programEntry" : False,
"header" : QApplication.translate("VcsPySvnPlugin",
"Version Control - Subversion (pysvn)"),
"text" ! text,
"version" : version,

}

return data

Listing 9: Example for the exeDisplayData() function returning a dictionary of type 2

5.3.6 exeDisplayDataL.ist()

In case the plugin has to report more than one external tool, it can define the function
exeDisplayDatalist in its module. The returned list has to consist of exeDisplayData type 1
or type 2 dictionaries (see 5.3.5 exeDisplayData()).
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def exeDisplayDatalist():
Public method to support the display of some executable info.
@return dictionary containing the data to query the presence of
the executable
datalList = []
# 1. eric6 _doc
exe = 'eric6 doc'
if Utilities.isWindowsPlatform():
exe = os.path.join(getConfig("bindir"), exe +'.bat"')
datalList.append({
"programEntry" : True,
"header" : QApplication.translate("EricdocPlugin",
"Eric6 Documentation Generator"),
"exe" 1 exe,
"versionCommand" : '--version',
"versionStartsWith" : 'eric6 ',
"versionPosition" 1 -3,
"version" A
"versionCleanup" : None,
})
# 2. Qt Help Generator
exe = 'ghelpgenerator'
if Utilities.isWindowsPlatform():
exe += ',exe'
datalList.append({
"programEntry" : True,
"header" : QApplication.translate("EricdocPlugin",
"Qt4 Help Tools"),
"exe" ! exe,
"versionCommand" VAN
"versionStartswWith" : 'Qt',
"versionPosition" -1,
"version" N
"versionCleanup" : (0, -1),
})
# 3. Qt Collection Generator
exe = 'gcollectiongenerator'
if Utilities.isWindowsPlatform():
exe += ',exe'
datalList.append({
"programEntry" : True,
"header" : QApplication.translate("EricdocPlugin",
"Qt4 Help Tools"),
"exe" I exe,
"versionCommand" A VAN
"versionStartswWith" : 'Qt‘',
"versionPosition" : -1,
"version" ",
"versionCleanup" (0, -1),
})
return datalist
Listing 10: Example for the exeDisplayDatalList() function returning a list of dictionaries of
type 1
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5.3.7 apiFiles(language)

This function may be provided by plug-ins providing API files for the autocompletion and
calltips system of eric6. The function must accept the programming language as a string
and return the filenames of the provided API files for that language as a list of string.

def apiFiles(language):

Module function to return the API files made available by this plugin.

@return list of API filenames (list of string)
if language == "Python":
apisDir =\
os.path.join(os.path.dirname( file ), "ProjectDjango", "APIs")
apis = glob.glob(os.path.join(apisDir, '*.api'))
else:
apis = [1]
return apis

Listing 11: Example for the apiFiles(language) function

5.3.8 clearPrivateData()

This function may be provided by plug-ins defining private data in order to clear them upon
requested by the user.

def clearPrivateData():

Module function to clear the private data of the plug-in.

for key in ["RepositoryUrlHistory"]:
VcsMercurialPlugin.setPreferences(key, [1)

Listing 12: Example for the clearPrivateData() function

5.4 Plug-in object methods

The plug-in class as defined by the className attribute must implement three mandatory
methods.

e _ init (self, ui)
e activate(self)
e deactivate(self)

These functions are described in more detail in the next few chapters.
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5.4.1 _ init__ (self, ui)

This method is the constructor of the plug-in object. It is passed a reference to the main
window object, which is of type UI.UserInterface. The constructor should be used to
perform all initialization steps, that are required before the activation of the plug-in object.
E.g. this would be the right place to load a translation file for the plug-in (s. Listing 16) and
to initialize default values for preferences values.

def init (self, ui):

Constructor

@param ui reference to the user interface object (UI.UserInterface)

Q0bject. init (self, ui)
self. ui = ui
self. initialize()

self. refactoringDefaults = {
"Logging" : 1

self. translator = None
self. TloadTranslator()

Listing 13: Example for the __init__(self, ui) method

Page 30 of 55



The eric6 plug-in system

5.4.2 activate(self)

def activate(self):

Public method to activate this plugin.

@return tuple of None and activation status (boolean)

global refactoringBRMPluginObject

refactoringBRMPluginObject = self

self. object = Refactoring(self, self. ui)

self. object.initActions()
e5App().registerPluginObject("RefactoringBRM", self. object)

self. mainMenu = self. object.initMenu()
extrasAct = self. ui.getMenuBarAction("extras")
self. mainAct = self. wui.menuBar()\
.insertMenu(extrasAct, self. mainMenu)
self. mainAct.setEnabled(\
e5App().getObject("ViewManager").getOpenEditorsCount())

self. editorMenu = self. initEditorMenu()
self. editorAct = self. editorMenu.menuAction()

self.connect(e5App().getObject("ViewManager"),
SIGNAL('lastEditorClosed'),
self. lastEditorClosed)
self.connect(e5App().getObject("ViewManager"),
SIGNAL("editorOpenedEd"),
self. editorOpened)
self.connect(e5App().getObject("ViewManager"),
SIGNAL("editorClosedEd"),
self. editorClosed)

self.connect(self. wui, SIGNAL('preferencesChanged'),
self. object.preferencesChanged)

self.connect (e5App().getObject("Project"), SIGNAL('projectOpened'),
self. object.projectOpened)
self.connect(e5App().getObject("Project”), SIGNAL('projectClosed'),
self. object.projectClosed)
self.connect(e5App().getObject("Project"), SIGNAL('newProject'),
)

self. object.projectOpened

for editor in e5App().getObject("ViewManager").getOpenEditors():
self. editorOpened(editor)

return None, True

Listing 14: Example for the activate(self) method

This method is called by the plug-in manager to activate the plug-in object. It must return a
tuple giving a reference to the object implementing the plug-in logic (for on-demand plug-
ins) or None and a flag indicating the activation status. This method should contain all the
logic, that is needed to get the plug-in fully operational (e.g. connect to some signals
provided by eric6). If the plug-in wants to provide an action to be added to a toolbar, this

Page 31 of 55



The eric6 plug-in system

action should be registered with the toolbar manager instead of being added to a toolbar
directly.

5.4.3 deactivate(self)

This method is called by the plug-in manager to deactivate the plug-in object. It is called
for modules, that have the deactivateable module attribute set to True. This method
should disconnect all connections made in the activate method and remove all menu
entries added in the activate method or somewhere else. If the cleanup operations are not
done carefully, it might lead to crashes at runtime, e.g. when the user invokes an action,
that is no longer available. If the plug-in registered an action with the toolbar manager, this
action must be unregistered.

def deactivate(self):

Public method to deactivate this plugin.

e5App () .unregisterPluginObject("RefactoringBRM")

self.disconnect(e5App().getObject("ViewManager"),
SIGNAL('lastEditorClosed'),
self. TlastEditorClosed)
self.disconnect (e5App().getObject("ViewManager"),
SIGNAL("editorOpenedEd"),
self. editorOpened)
self.disconnect (e5App().getObject("ViewManager"),
SIGNAL ("editorClosedEd"),
self. editorClosed)

self.disconnect(self. ui, SIGNAL('preferencesChanged'),
self. object.preferencesChanged)

self.disconnect(e5App().getObject("Project"), SIGNAL('projectOpened'),
self. object.projectOpened)

self.disconnect (e5App().getObject("Project"), SIGNAL('projectClosed'),
self. object.projectClosed)

self.disconnect(e5App().getObject("Project"), SIGNAL('newProject'),
self. object.projectOpened)

self. wui.menuBar().removeAction(self. mainAct)

for editor in self. editors:
self.disconnect(editor, SIGNAL("showMenu"), self. editorShowMenu)
menu = editor.getMenu("Main")
if menu is not None:
menu.removeAction(self. editorMenu.menuAction())

self. initialize()

Listing 15: Example for the deactivate(self) method
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5.4.4 _ loadTranslator(self)

The constructor example shown in Listing 13 loads a plug-in specific translation using this
method. The way, how to do this correctly, is shown in the following listing. It is important to
keep a reference to the loaded QTranslator object. Otherwise, the Python garbage
collector will remove this object, when the method is finished.

def  loadTranslator(self):

Private method to load the translation file.
loc = self. ui.getlLocale()
if loc and loc != "C":
locale dir = os.path.join(os.path.dirname( file ),
"RefactoringBRM", "i18n")
translation = "brm %s" % loc
translator = QTranslator(None)
loaded = translator.load(translation, locale dir)
if loaded:
self. translator = translator
e5App().installTranslator(self. translator)
else:
print "Warning: translation file '%s' could not be loaded." \
% translation
print "Using default."

Listing 16: Example for the __loadTranslator(self) method

5.4.5 initToolbar(self, ui, toolbarManager)

This method must be implemented, if the plug-in supports a toolbar for its actions. Such
toolbar will be removed, when the plug-in is unloaded. An example is shown in Listing 17.

def initToolbar(self, ui, toolbarManager):

Public slot to initialize the VCS toolbar.

@param ui reference to the main window (UserInterface)

@param toolbarManager reference to a toolbar manager object
(E5ToolBarManager)

if self. projectHelperObject:
self. projectHelperObject.initToolbar(ui, toolbarManager)

Listing 17: Example for the initToolbar(self, ui, toolbarManager) method

5.4.6 prepareUnload(self)

This method must be implemented to prepare the plug-in to be unloaded. It should revert
everything done when the plug-in was instantiated and remove plug-in toolbars generated
with initToolbar (). Listing 18 shows an example.
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def prepareUnload(self):

Public method to prepare for an unload.
if self. projectHelperObject:
self. projectHelperObject.removeToolbar(
self. wui, e5App().getObject("ToolbarManager"))
e5App () .unregisterPluginObject(pluginTypename)

Listing 18: Example for the prepareUnload(self) method

6 Eric6 hooks

This chapter describes the various hooks provided by eric6 objects. These hooks may be
used by plug-ins to provide specific functionality instead of the standard one.

6.1 Hooks of the project browser objects

Most project browser objects (i.e. the different tabs of the project viewer) support hooks.
They provide methods to add and remove hooks.

e addHookMethod(key, method)
This method is used to add a hook method to the individual project browser. “key”
denotes the hook and “method” is the reference to the hook method. The supported
keys and the method signatures are described in the following chapters.

e addHookMethodAndMenuEntry(key, method, menuEntry)
This method is used to add a hook method to the individual project browser. “key”
denotes the hook, “method” is the reference to the hook method and “menuEntry” is
the string to be shown in the context menu. The supported keys and the method
signatures are described in the following chapters.

e removeHookMethod(key)
This method is used to remove a hook previously added. “key” denotes the hook.
Supported keys are described in the followings chapters.

6.1.1 Hooks of the ProjectFormsBrowser object
The ProjectFormsBrowser object supports hooks with these keys.

e compileForm
This hook is called to compile a form. The method must take the filename of the
form file as its parameter.

e compileAllForms
This hook is called to compile all forms contained in the project. The method must
take a list of filenames as its parameter.

e compileChangedForms
This hook is called to compile all changed forms. The method must take a list of
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filenames as its parameter.

compileSelectedForms
This hook is called to compile all forms selected in the project forms viewer. The
method must take a list of filenames as its parameter.

generateDialogCode
This hook is called to generate dialog source code for a dialog. The method must
take the filename of the form file as its parameter.

newForm
This hook is called to generate a new (empty) form. The method must take the
filename of the form file as its parameter.

open
This hook is called to open the selected forms in a forms designer tool. The method
must take the filename of the form file as its parameter.

6.1.2 Hooks of the ProjectResourcesBrowser object
The ProjectResourcesBrowser object supports hooks with these keys.

compileResource
This hook is called to compile a resource. The method must take the filename of the
resource file as its parameter.

compileAllResources
This hook is called to compile all resources contained in the project. The method
must take a list of filenames as its parameter.

compileChangedResources
This hook is called to compile all changed resources. The method must take a list of
filenames as its parameter.

compileSelectedResources
This hook is called to compile all resources selected in the project resources viewer.
The method must take a list of filenames as its parameter.

newResource
This hook is called to generate a new (empty) resource. The method must take the
filename of the resource file as its parameter.

6.1.3 Hooks of the ProjectTranslationsBrowser object
The ProjectTranslationsBrowser object supports hooks with these keys.

extractMessages

This hook is called to extract all translatable strings out of the application files. The
method must not have any parameters. This hook should be used, if the translation
system is working with a translation template file (e.g. *.pot) from which the real
translation files are generated with the generate. .. methods below.

generateAll
This hook is called to generate translation files for all languages of the project. The
method must take a list of filenames as its parameter.
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6.2

generateAllwithObsolete
This hook is called to generate translation files for all languages of the project
keeping obsolete strings. The method must take a list of filenames as its parameter.

generateSelected

This hook is called to generate translation files for languages selected in the project
translations viewer. The method must take a list of filenames as its parameter.

generateSelectedwithObsolete

This hook is called to generate translation files for languages selected in the project
translations viewer keeping obsolete strings. The method must take a list of
filenames as its parameter.

releaseAll
This hook is called to release (compile to binary) all languages of the project. The
method must take a list of filenames as its parameter.

releaseSelected

This hook is called to release (compile to binary) all languages selected in the
project translations viewer. The method must take a list of filenames as its
parameter.

open
This hook is called to open the selected languages in a translation tool. The method
must take the filename of the translations file as its parameter.

Hooks of the Editor object

The Editor object provides hooks for autocompletion and calltips. These are the
methods provided to set, unset and get these hooks.

setAutoCompletionHook(self, func)

This method is used to set an autocompletion hook. The function or method passed
in the call must take a reference to the editor and a boolean indicating to complete a
context.

unsetAutoCompletionHook(self)
This method unsets a previously set autocompletion hook.

autoCompletionHook()
This method returns a reference to the method set by a call to
setAutoCompletionHook(self).

setCallTipHook(self, func)

This method is used to set a calltips hook. The function or method passed in the call
must take a reference to the editor, a position into the text and the amount of
commas to the left of the cursor. It should return the possible calltips as a list of
strings.

unsetCallTipHook(self)
This method unsets a previously set calltips hook.

callTipHook(self)
This method returns a reference to the method set by a call to
setCallTipHook(self).
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7 Eric6 functions available for plug-in development

This chapter describes some functionality, that is provided by ericé and may be of some
value for plug-in development. For a complete eric6 API description please see the
documentation, that is delivered as part of eric6.

7.1

The eric6 object registry

Eric6 contains an object registry, that can be used to get references to some of eric6's
building blocks. Objects available through the registry are

BackgroundService
This object gives access to non blocking remote procedure calls to execute
functions on different Python versions. Refer to chapter 9 “The BackgroudService*.

Cooperation
This is the object responsible for chatting between eric6 instantiations and for
shared editing.

DebugServer
This is the interface to the debugger backend.

DebugUI
This is the object, that is responsible for all debugger related user interface
elements.

IRC
This object is a simplified Internet Relay Chat client.

MultiProject
This is the object responsible for the management of a set of projects

Numbers
This object handles the number conversion.

PluginManager
This is the object responsible for managing all plug-ins.

Project
This is the object responsible for managing the project data and all project related
user interfaces.

ProjectBrowser

This is the object, that manages the various project browsers. It offers (next to
others) the method getProjectBrowser () to get a reference to a specific project
browser (s. the chapter below)

Shell
This is the object, that implements the interactive shell (Python or Ruby).

Symbols
This object implements the symbol selection lists.

SyntaxCheckService

This object implements the online syntax check service interface for Python 2 and
3. Other languages can register to this service and getting checked as well. It's
described in chapter 9.2 “The SyntaxCheckService".
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TaskViewer
This is the object responsible for managing the tasks and the tasks related user
interface.

TemplateViewer
This is the object responsible for managing the template objects and the template
related user interface.

Terminal
This is the object, that implements the simple terminal window.

ToolbarManager

This is the object responsible for managing the toolbars. Toolbars and actions
created by a plug-in should be registered and unregistered with the toolbar
managetr.

UserInterface
This is eric6é main window object.

ViewManager
This is the object, that is responsible for managing all editor windows as well as all
editing related actions, menus and toolbars.

Eric6's object registry is used as shown in this example.

from E5Gui.E5Application import e5App

e5App().getObject("Project")

Listing 19: Example for the usage of the object registry

The object registry provides these methods.

getObject(name)
This method returns a reference to the named object. If no object of the given name
is registered, it raises a KeyError exception.

registerPluginObject(name, object)

This method may be used to register a plug-in object with the object registry.
“name” must be a unique name for the object and “object” must contain a reference
to the object to be registered. If an object with the given name has been registered
already, a KeyError exception is raised.

unregisterPluginObject(name)
This method may be used to unregister a plug-in object. If the named object has not
been registered, nothing happens.

getPluginObject(name)
This method returns a reference to the named plug-in object. If no object of the
given name is registered, it raises a KeyError exception.

getPluginObjects()
This method returns a list of references to all registered plug-in objects. Each list
element is a tuple giving the name of the plug-in object and the reference.
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7.2

The action registries

Actions of type E5Action may be registered and unregistered with the Project or the
UserInterface object. In order for this, these objects provide the methods

7.3

Project.addE5Actions(actions)
This method registers the given list of E5Action with the Project actions.

Project.removeE5Actions(actions)
This method unregisters the given list of E5Action from the Project actions.

UserInterface.addE5Actions(actions, type)
This method registers the given list of ESActions with the UserInterface actions
of the given type. The type parameter may be “ui” or “wizards”

UserInterface.removeES5Actions(actions, type)
This method unregisters the given list of E5Actions from the UserInterface
actions of the given type. The type parameter may be “ui”’ or “wizards”

The getMenu() methods

In order to add actions to menus, the main eric6 objects Project, Editor and
UserInterface provide the method getMenu(menuName). This method returns a
reference to the requested menu or None, if no such menu is available. menuName is the
name of the menu as a Python string. Valid menu names are:

Project

e Main
This is the project menu

e Recent
This is the submenu containing the names of recently opened projects.

e VCS
This is the generic version control submenu.

e Checks
This is the “Check” submenu.

e Show
This is the “Show” submenu.

e Graphics
This is the “Diagrams” submenu.

e Session
This is the “Session” submenu.
e Apidoc
This is the “Source Documentation” submenu.

e Debugger
This is the “Debugger” submenu.

e Packagers
This is the “Packagers” submenu.

Page 39 of 55



The eric6 plug-in system

e Editor

Main
This is the editor context menu (i.e. the menu appearing, when the right
mouse button is clicked)

Resources
This is the “Resources” submenu. It is only available, if the file of the editor is
a Qt resources file.

Checks
This is the “Check” submenu. It is not available, if the file of the editor is a Qt
resources file.

Tools

This is the “Tools” submenu. It is deactivated, if it has not been populated by
some plug-ins.

Show

This is the “Show” submenu. It is not available, if the file of the editor is a Qt
resources file.

Graphics
This is the “Diagrams” submenu. It is not available, if the file of the editor is a
Qt resources file.

Autocompletion
This is the “Autocomplete” submenu. It is not available, if the file of the editor
is a Qt resources file.

Exporters

This is the “Exporters” submenu.

Languages

This is the submenu for selecting the programming language.

Eol
This is the submenu for selecting the end-of-line style.

Encodings
This is the submenu for selecting the character encoding.

e Userinterface

file

This is the “File” menu.

edit

This is the “Edit” menu

view

This is the “View” menu.

start
This is the “Start” menu.

debug
This is the “Debug” menu.
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e unittest

This is the “Unittest” menu.
e project

This is the “Project” menu.

e extras
This is the “Extras” menu.

e Wwizards
This is the “Wizards” submenu of the “Extras” menu.

e macros
This is the “Macros” submenu of the “Extras” menu.

e tools
This is the “Tools” submenu of the “Extras” menu.

e settings
This is the “Settings” menu.

e window
This is the “Window” menu.

e subwindow
This is the “Windows” submenu of the “Window” menu

e toolbars
This is the “Toolbars” submenu of the “Window” menu.

e bookmarks

This is the “Bookmarks” menu.
e plugins

This is the “Plugins” menu.

e help
This is the “Help” menu.

7.4 Methods of the PluginManager object

The PluginManager object provides some methods, that might be interesting for plug-in
development.

e isPluginLoaded(pluginName)
This method may be used to check, if the plug-in manager has loaded a plug-in with
the given plug-in name. It returns a boolean flag.

7.5 Methods of the Userinterface object

The UserInterface object provides some methods, that might be interesting for plug-in
development.

e (getMenuAction(menuName, actionName)
This method returns a reference to the requested action of the given menu.
menuName is the name of the menu to search in (see above for valid names) and
actionName is the object name of the action.
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e getMenuBarAction(menuName)
This method returns a reference to the action of the menu bar associated with the
given menu. menuName is the name of the menu to search for.

e registerToolbar(name, text, toolbar)
This method is used to register a toolbar. name is the name of the toolbar as a
Python string, text is the user visible text of the toolbar as a string and toolbar is
a reference to the toolbar to be registered. If a toolbar of the given name was
already registered, a KeyError exception is raised.

e unregisterToolbar(name)
This method is used to unregister a toolbar. name is the name of the toolbar as a
Python string.

e getToolbar(name)
This method is used to get a reference to a registered toolbar. If no toolbar with the
given name has been registered, None is returned instead. name is the name of the
toolbar as a Python string.

e addSidewidget(side, widget, icon, label)
This method is used to add a widget to one of the valid sides. Valid values for the
side parameter are UserInterface.LeftSide and
UserInterface.BottomSide.

e removeSidewidget(widget)
This method is used to remove a widget that was added using the previously
described method. All valid sides will be searched for the widget.

e getlLocale()
This method is used to retrieve the application locale as a Python string.

e versionIsNewer(required, snapshot = None)
This method is used to check, if the eric6 version is newer than the one given in the
call. If a specific snapshot version should be checked, this should be given as well.
“snapshot” should be a string of the form “yyyymmdd”, e.g. “20080719". If no
snapshot is passed and a snapshot version of eric6 is discovered, this method will
return True assuming, that the snapshot is new enough. The method returns True, if
the eric6 version is newer than the given values.

7.6 Methods of the E5ToolBarManager object

The E5ToolBarManager object provides methods to add and remove actions and
toolbars. These actions and toolbars are used to build up the toolbars shown to the user.
The user may configure the toolbars using a dialog. The list of available actions are those,
managed by the toolbar manager.

e addAction(action, category)
This method is used to add an action to the list of actions managed by the toolbar
manager. action is a reference to a QAction (or derived class); category is a
string used to categorize the actions.

e removeAction(action)
This method is used to remove an action from the list of actions managed by the
toolbar manager. action is a reference to a QAction (or derived class).
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e addToolBar(toolBar, category)
This method is used to add a toolbar to the list of toolbars managed by the toolbar
manager. toolBar is a reference to a QToolBar (or derived class); category is a
string used to categorize the actions of the toolbar.

e removeToolBar(toolBar)
This method is used to remove a toolbar from the list of toolbars managed by the
toolbar manager. toolBar is a reference to a QToolBar (or derived class).

7.7 Methods of the Project object

The Project object provides methods to store and retrieve data to and from the project
data store. This data store is saved in the project file.

e (getData(category, key)
This method is used to get data out of the project data store. category is the
category of the data to get and must be one of

e CHECKERSPARMS
Used by checker plug-ins.

o PACKAGERSPARMS
Used by packager plug-ins.

e DOCUMENTATIONPARMS
Used by documentation plug-ins.

e OTHERTOOLSPARMS
Used by plug-ins not fitting the other categories.

The key parameter gives the key of the data entry to get and is determined by the
plug-in. A copy of the requested data is returned.

e setData(category, key, data)
This method is used to store data in the project data store. category is the
category of the data to store and must be one of

e CHECKERSPARMS
Used by checker plug-ins.

e PACKAGERSPARMS
Used by packager plug-ins.

e DOCUMENTATIONPARMS
Used by documentation plug-ins.

e OTHERTOOLSPARMS
Used by plug-ins not fitting the other categories.

The key parameter gives the key of the data entry to get and is determined by the
plug-in. data is the data to store. The data is copied to the data store by using the
Python function copy .deepcopy().

In addition to this the Project object contains methods to register and unregister
additional project types.

e registerProjectType(type_, description, fileTypeCallback =
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None,

binaryTranslationsCallback = None,

lexerAssociationCallback = None)
This method registers a new project type provided by the plugin. The parameters to
be passed are

type_
This is the new project type as a Python string.

description
This is the string shown by the user interface. It should be a translatable
string of the project type as a string.

fileTypeCallback

This is a reference to a function or method returning a dictionary associating
a filename pattern with a file type (e.g. *.html -> FORMS). The file type must
be one of

e FORMS

e INTERFACES

e RESOURCES

e SOURCES

e TRANSLATIONS

binaryTranslationsCallback
This is a reference to a function or method returning the name of the binary
translation file given the name of the raw translation file.

lexerAssociationCallback
This is a reference to a function or method returning the lexer name to be
used for syntax highlighting given the name of a file (e.g. *.html -> Django)

e unregisterProjectType(self, type_)
This method unregisters a project type previously registered with the a.m. method.
type_ must be a known project type.

7.8 Methods of the ProjectBrowser object

The ProjectBrowser object provides some methods, that might be interesting for plug-
in development.

e getProjectBrowser(name)
This method is used to get a reference to the named project browser. name is the
name of the project browser as a Python string. Valid names are

sources
forms
resources
translations
interfaces
others
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7.9

getProjectBrowsers()

This method is used to get references to all project browsers. They are returned as
a Python list in the order

e project sources browser

e project forms browser

e project resources browser
e project translations browser
e project interfaces browser
e project others browser

Methods of QScintilla.Lexer

The QScintilla.Lexer package provides methods to register and unregister lexers
(syntax highlighters) provided by a plugin.

registerLexer(name, displayString, filenameSample,
getLexerFunc, openFilters = [],

saveFilters = [], defaultAssocs = [])

This method is used to register a new custom lexer. The parameters are as follows.

e Nname
This parameter is the name of the new lexer as a Python string.

e displayString
This parameter is the string to be shown in the user interface as a string.

e filenameSample
This parameter should give an example filename used to determine the
default lexer of a file based on its name (e.g. dummy.django). This parameter
should be given as a Python string.

e (getlLexerFunc
This is a reference to a function instantiating the specific lexer. This function
must take a reference to the parent as its only argument and return the
reference to the instantiated lexer object.

e openFilters
This is a list of open file filters to be used in the user interface as a 1ist of
strings..

e saveFilters
This is a list of save file filters to be used in the user interface as a 1ist of
strings.

e defaultAssocs

This gives the default lexer associations as a list of strings of filename
wildcard patterns to be associated with the lexer

unregisterLexer(name)

This method is used to unregister a lexer previously registered with the a.m.
method. name must be a registered lexer.
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7.10 Signals

This chapter lists some Python type signals emitted by various eric6 objects, that may be
interesting for plug-in development.

showMenu

This signal is emitted with the menu name as a Python string and a reference to the
menu object, when a menu is about to be shown. It is emitted by these objects.

e Project
It is emitted for the menus

Main
the Project menu

VCS
the Version Control submenu

Checks
the Checks submenu

Packagers

the Packagers submenu

ApiDoc

the Source Documentation submenu

Show
the Show submenu

Graphics
the Diagrams submenu

e ProjectSourcesBrowser
It is emitted for the menus

Main

the context menu for single selected files

MainMulti

the context menu for multiple selected files

MainDir

the context menu for single selected directories

MainDirMulti

the context menu for multiple selected directories

MainBack
the background context menu

Show
the Show context submenu

Checks
the Checks context submenu

Graphics
the Diagrams context submenu
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e ProjectFormsBrowser
It is emitted for the menus

Main

the context menu for single selected files
MainMulti

the context menu for multiple selected files
MainDir

the context menu for single selected directories

MainDirMulti
the context menu for multiple selected directories

MainBack
the background context menu

e ProjectResourcesBrowser
It is emitted for the menus

Main

the context menu for single selected files
MainMulti

the context menu for multiple selected files
MainDir

the context menu for single selected directories

MainDirMulti
the context menu for multiple selected directories

MainBack
the background context menu

e ProjectTranslationsBrowser
It is emitted for the menus

Main

the context menu for single selected files
MainMulti

the context menu for multiple selected files
MainDir

the context menu for single selected directories

MainBack
the background context menu

e ProjectInterfacesBrowser
It is emitted for the menus

Main
the context menu for single selected files

MainMulti
the context menu for multiple selected files
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MainDir
the context menu for single selected directories

MainDirMulti
the context menu for multiple selected directories

MainBack
the background context menu

ProjectOthersBrowser
It is emitted for the menus

Main
the context menu for single selected files

MainMulti
the context menu for multiple selected files

MainBack
the background context menu

Editor
It is emitted for the menus

Main

the context menu

Languages

the Languages context submenu

Encodings
the Encodings context submenu

Eol
the End-of-Line Type context submenu

Autocompletion
the Autocomplete context submenu

Show

the Show context submenu
Graphics

the Diagrams context submenu
Margin

the margin context menu

Checks
the Checks context submenu

Tools
the Tools context submenu

Resources
the Resources context submenu

UserInterface
It is emitted for the menus
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e File
the File menu

e Extras
the Extras menu

e Wizards
the Wizards submenu of the Extras menu

e Tools
the Tools submenu of the Extras menu

e Help
the Help menu

e Windows
the Windows menu

e Subwindows
the Windows submenu of the Windows menu

editorOpenedEd
This signal is emitted by the ViewManager object with the reference to the editor
object, when a new editor is opened.

editorClosedEd
This signal is emitted by the ViewManager object with the reference to the editor
object, when an editor is closed.

lastEditorClosed
This signal is emitted by the ViewManager object, when the last editor is closed.

projectOpenedHooks()
This signal is emitted by the Project object after a project file was read but before
the projectOpened() signal is sent.

projectClosedHooks()
This signal is emitted by the Project object after a project file was clsoed but
before the projectClosed() signal is sent.

newProjectHooks()
This signal is emitted by the Project object after a new project was generated but
before the newProject() signal is sent.

projectOpened
This signal is emitted by the Project object, when a project is opened.

projectClosed
This signal is emitted by the Project object, when a project is closed.

newProject
This signal is emitted by the Project object, when a new project has been
created.

preferencesChanged
This signal is emitted by the UserInterface object, when some preferences have
been changed.
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e EditorAboutToBeSaved
This signal is emitted by the each Editor object, when the editor contents is about
to be saved. The filename is passed as a parameter.

e EditorSaved
This signal is emitted by the each Editor object, when the editor contents has
been saved. The filename is passed as a parameter.

e EditorRenamed

This signal is emitted by the each Editor object, when the editor has received a
new filename.

8 Special plug-in types

This chapter describes some plug-ins, that have special requirements.

8.1 VCS plug-ins

VCS plug-ins are loaded on-demand depending on the selected VCS system for the
current project. VCS plug-ins must define their type by defining the module attribute
pluginType like

pluginType = "version control"

VCS plug-ins must implement the getVcsSystemIndicator () module function. This
function must return a dictionary with the indicator as the key as a Python string and a
tuple of the VCS name (Python string) and the VCS display string (string) as the value. An
example is shown below.

def getVcsSystemIndicator():

Public function to get the indicators for this version control system.

@return dictionary with indicator as key and a tuple with the vcs name
(string) and vcs display string (string)

global displayString, pluginTypename

data = {}

data[".svn"]

data[" svn"]

return data

(pluginTypename, displayString)
(pluginTypename, displayString)

Listing 20: Example of the getVcsSystemindicator() function

8.2 ViewManager plug-ins

ViewManager plug-ins are loaded on-demand depending on the selected view manager.
The view manager type to be used may be configured by the user through the
configuration dialog. ViewManager plug-ins must define their type by defining the module
attribute pluginType like

pluginType = "viewmanager"
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The plug-in module must implement the previewPix () method as described above.

9 The BackgroudService

Introduced with Eric 5.5, the background service becomes part of the core system. It's a
kind of remote procedure call, but other than, e.g. XMLRPC or CORBA, it's non blocking.
Mainly developed to simplify the problems with some core modules, where the execution
depends on the different Python versions, it could be used by other plug-ins as well. Even
other languages than Python could be attached to the server side of the background
service, to enhance Eric 5.

On the start of Eric, typically the Python 2 and 3 interpreters are started with Eric and
some core plug-ins use them. Which interpreter is started, depends on the interpreter
given in Settings — Debugger.

Based on the BackgroudService there are some core plug-ins which use it already to do
their tasks.

9.1 How to access the background service

The interface, the background service supports, is quite simple. First of all, a plug-in has to
get access to it through the object registry (refer to 7.1 “The eric6 object registry*).

Now it has access to the background service interface (the server side) and can announce
its functions. Therefore the method serviceConnect must be called. To keep the
background service universal, a plug-in has to specify, e.g. the callback function which
itself can emit a self defined signal.

self.backgroundService = e5App().getObject("BackgroundService")

self.backgroundService.serviceConnect(
'style', lang, path, 'CodeStyleChecker',
self. translateStyleCheck,
lambda fx, fn, ver, msg: self.styleChecked.emit(
fn, {}, 0, [[0, 0, '---- ' + msg, False, Falsell))

Listing 21: Example of a serviceConnect

The signature is

serviceConnect(fx, lang, modulepath, module, callback,
onErrorCallback=None)

with
X
Function name with which the service should be named.

lang
Language for which this call should be implemented.

modulepath
Full path to the module.
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module
Module name without extension.

callback
Function which should be called after successful execution.

onErrorCallback
Function which should be called if anything unexpected happened.

Each plug-in which is based on Python has to support a special function initService.
The initService function has to return the main service function pointer and has to

initialize everything that is needed by the plug-in main function, e.g. create the object if it's
a class method instead of a simple function.

After a successful serviceConnect, the plug-in can request a remote procedure call
through the enqueueRequest method provided by the background service. The plug-in
therefore has to use the registered service name. Furthermore it has to provide the
language to use and an identifier. This identifier can be used to match the
engueueRequest call with the corresponding callback. Typically the file name is used,
but other basic data types like integer or float could be used. The last parameter contains
a list of function arguments, which are transferred to the remote procedure. Any basic data

type can be used as arguments, but tuples are converted to lists by the underlying JSON
module.

self.backgroundService.enqueueRequest('syntax', lang, filename, data)

Listing 22: Example of enqueueing a request

The signature is
engueueRequest(fx, lang, fn, data)
with

fx

Function name with which the service should be named.

lang

Language for which this call should be implemented.

fn

Identifier to determine the callback to the service request.

data

List of any basic datatypes. These are the former arguments of the method call.
As the method name implies, the call of enqueueRequest only enqueues the request. If
other requests are pending, the processing waits until it's his turn. In the current
implementation this is also true if the language to use isn't busy. Future plug-ins should
therefore be cooperative and wait for the response instead of enqueueing all their tasks.
To avoid an overflow, only the arguments of a pending task are updated. This is the case if

the service name, the language and the identifier are all the same on a new
engueueRequest call. But the position in the queue isn't changed.

On unload of a plug-in, it can remove the connection to the background service by calling
serviceDisconnect.
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self.backgroundService.serviceDisconnect('syntax', lang)

Listing 23: Example of disconnecting from a service

The signature is
serviceDisconnect(fx, lang)
with
X
Function name which should be disconnected.

lang
Language for which the function name fx should be disconnected.

9.2 The SyntaxCheckService

Based on the background service, another general service was introduced. With the
syntax check service, other languages than Python can implement a syntax check and
reuse the dialogs and recurring checks for open files. Therefore a special interface is
created to include the new language to the existing checking mechanism.

Like the background service, the SyntaxCheckService is also added to the Eric 5 object
registry (see SyntaxCheckService).

A new language has to register itself to the syntax checker by calling addLanguage.
Additionally the new language has to implement the client side of the syntax checker. One
way is to use the existing client side implemented in Python to call the checker. But this is
very slow because of the overhead which comes from starting the syntax checker over and
over again. It's better, to implement a new client side in the programming language the
checker finally is. A good starting point for this is to look in Utilities/BackgroundClient.py.

addLanguage takes some parameters to handle the new programming language. The
example shows the call from PluginSyntaxChecker.py

self.syntaxCheckService.addLanguage(
'Python2', 'Python2', path, 'SyntaxCheck',
self. getPythonOptions,
lambda: Preferences.getPython("PythonExtensions"),
self. translateSyntaxCheck,
lambda fx, lng, fn, msg: \
self.syntaxCheckService.syntaxChecked.emit (
fn, True, fn, 0, 0, "', msg, []))

Listing 24: Example of registering a language

The signature is

addLanguage(lang, env, path, module, getArgs, getExt, callback,
onError)
with

lang

The language which is to be registered. The name of the language is used in
subsequent calls from the checker dialog.
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env
The environment in which the checker is implemented.

path
The full path to the module which has to be imported.

module
The name of the module.

getArgs
Function pointer: Options and parameters which could be set by the user, e.g.
through the preferences menu, are returned. It's called before every check of a file.

getExt
Function pointer: Returns a list of extensions which are supported by the language
checker plugin.

callback
Function pointer: When the syntax check request has finished, this method is called
by the background service.

onError

Function pointer: If an error happens, the callback function won't be called by the
background service. To report that error and continue with the next request, the
onError function is called. It should generate the same signature like the
callback function.

path and module are the same as in the background service serviceConnect method.
Depending on the import mechanisms of the language and the client implementation it
may be not necessary to provide path and / or module. In this case just empty strings
should be enough.

The problems reported back to the callback method are stored in a dictionary which can
hold two keys: error and warnings. The values of those keys are similar: the error key
holds only the first five arguments and is a one dimensional list. The warnings key holds a
two dimensional list (list of lists) and uses all arguments. The arguments and their
sequence in the list are as follows:

filename

The file name where the problem was found. This should always be the same like
the checked file name.

line

The line number starting from 1 where the problem was found.

column

The column where the problem was found or O when it wasn't possible to determine
the exact position.

code
In case of a syntax error the source code line otherwise an empty string.

message
The message of the problem. The translation is done on the server side because
the client has not to know how to translate the messages to the installed user
language.
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arguments
A list of arguments which has to be inserted into the translated message text. Does
not exist in the error key.
It's also possible to deactivate a language by calling removeLanguage with the name of
the language.
To query which languages are already registered, a plug-in can call getLanguages to get
a list with the names of the registered languages.
To filter out the unsupported files, a plug-in can check for a correct file extension by
retrieving the registered extensions with a call of getExtensions. It returns a list of
supported file extensions.

At last a plug-in could start a check for a file by itself, by calling syntaxCheck. The
signature is

syntaxCheck(lang, filename, source="")
with

lang
The language which is to be used or None to determine the language based on its
extension.

filename
The file name or unique identifier like in enqueueRequest (see identifier page 52).

source
The source code to check.
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